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PURPOSE

This SOP describes how to operate and use the Varian eclipse fluorescence spectrophotometer (200-900
nmrange) locatedin the CAF facility. More specifically, how to perform a fluorescence scan using the Scan
application. For more information on the instrument please APPENDIXF.

SCOPE

This SOP describes procedures to be followed by staff and students when using the Varian eclipse
fluorescence spectrophotometer in the CAF facility.

RISKS.

DO complete the CAF Blackboard safety test, official training and ONE run supervised by the CAF
technician before using the equipment.

See the attached Risk assessment of the instrument.

You must have your own Risk assessment of the chemical products you are going to analyse.

Please if you want to analyse toxic, flammable, explosive, or longer term health hazards chemicals talk with
the CAF technician before running your samples (check their MSDS). We may need to take extra safety

measures.

Lenger term health Toxic
hazards such as
carcine genicity Explosive Elammakbie

PROCEDURE.

PRECAUTIONS

e DO NOT spill solvents inside the cell compartment. Report any spills.

e DO NOT leave sample waste, glassware or other materials in the lab without properly disposing of
them. In some cases, this may require that you bring the waste back to your own lab.

e Please look for technical assistance if you face any instrument warning/error.

e Donotattempt to use if signage indicates that the instrument is out of use oris currently in use,
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INSTRUMENT STARTUP

- The computer should be on already. You just need to ‘wake’ it up. Log on to the Caffluo user, password:
Caffluo. If somebody has signed out you will need to sig in to the PC:

Username: PC domain\ Caffluo Password: Caffluo

Do not log on to Rdg-home with your individual logon as the instrument specific software will not function.

- Enterin the application that you want to use. Double-click on the Cary Eclipse folder program folder icon
on the computer desktop. A folder will open showing all of the acquisition and processing programs. If you
use micro cuvettes, checking the alignment of the cell changer with the align app is always recommended
before analysing your samples. See Appendix A for more information.

During the basic training session all users are shown how to use the "Scan” application, align the cell
changer and how to use the "Cary Help" application. The other applications (Figure 1) are discussed briefly
at the end of this document in Appendix B, but operational details are not included here. You may request
advanced training to use any of the other programs.

At the moment, we have only installed a temperature controller and a multicell holder. However, we have
other accessories that you may need (See Appendix C), for more information look for technical assistance.
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Figure 1, Cary Applications. The GLP (Good Laboratory Practice) Administration application is not compatible with Microsoft
Windows 7 and Windows 10 operating systems.

- Turn on the instrument. The switch is at the lower right corner. Wait at least two minutes for the
instrument to complete hardware initialization. Check for the different messages that appear at the
bottom left corner of the application, they could indicate a problem.

- Liftthe lidandcheckto seeif any samples are stillinthe instrument. If so, contact the previous user before
removing them to prevent interference with another experiment or potential risk to oneself.
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- If you want to controlthe T of your experiment turn on the T controller which is next to the instrument. If
you hear a strange noise or see any leak please let the engineer knows.

CAUTION:

To avoid overheating and prevent accidents do not leave the T controller on for long perfods of time.
If you are going to run analysis for the whole day, please first Jook for technical assistance.

SCANAPPLICATION.

These procedure steps are based on the Cary help menu < How to perform a fluorescence scan using the
Scan application.

- The software should now openin the standard view. The view should clearly indicate that the instrument
is "Scan - Online” and the "Start" traffic light button should be green (not greyed out) (Figure 2). If the
program indicates "Scan — Offline", then exit the program and start the Scan program again. If you do not
see the green traffic light yet, close the scan tab and go to the right bottom of the task bar and close an
icon that it may be open: “system information”. Now you can open the scan tab again.

Online
Live [ Scan [Method:-C:-\Cany\.. \Anthiacene Miror Image. FBSW]- Online Monochromator
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Flgure 2. Scan application.

- From the File pull-down menu, select "Open Method" if you have a method saved. Navigate to the
Methods folder, then double-click to select the method you would like to use.

- If you do not have a method saved or you want to modify your method: Use the Setup button

Setup ...
LI to access and modify all of the method parameters or to set a method from scratch.
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Setup parameters:

a. Carytab:
Set the Data Mode to Fluorescence.

Set the Scan Setup mode to Emission to get a fluorescence analysis of your sample (more
information in APPENDIX F). During the emission scan, the excitation monochromator is set to a

fixed wavelength and the emission monochromator is scanned over a wavelength range.

Set the X Mode to Wavelength (nm).

Enter an Excitation (nm) value that is within the region where the fluorescent molecule to be
scanned will absorb light. The instrument covers the wavelength range 200-900 nm in excitation
and emission. Do not select the zero order option.

Enter an Excitation slit (nm) value of 5 and an Emission slit (nm) value of 5 (default values). Slits
determine the resolution of the spectrum and therefore are used in conjunction with the PMT
Detector Voltage (set on the Options page) to determine concentration. If a compound is highly
fluorescent and has reasonable signal intensity (as is the case for anthracene), the slits can be set
quite narrow. The difference inintensity is very significant, with nearly 50 fold increase from 1.5 nm
slit (ex) to 2.5 (in the theory ppt it says that doubling emission slit results in an increase of approx.

x4). Use narrowest slits for complex spectral shape or very bright fluorophores.

Enter a (emission) Start (hm) value and a Stop (nm) value. The Start (nm) value should be set to the
Excitation (nm) value plus the sum of the slits. For example, for anthracene, an excitation value of
360nm should be set. Then, the sum of the slits is 10 nm, so the Start (nm) value is set to 370.
Typically the Stop (nm) value should be set to 150-200 nm greater than the Start (nm) value.

If selected, clear the 3-D Mode check box.

Now you need to set the speed of the data collection. With the Cary instruments you do this by
settingthe Ave Time and Data Interval, set the Scan Control to Medium, which corresponds to 0.1s
and 1nm, respectively. This is a good starting point, you can also set it manually. The Data Interval
field indicates the wavelength increment you require between data points. The Cary will
automatically update the Scan Rate field when you select the previous parameters. A Data interval

of 1 means that every 1nm you record one point,

Select the Status Display check box so that you can view various instrument parameters during the
scan.

b. Select the Options tab.

In the Display Options group, select the Overlay traces check box to overlay the results of the
traces (scans) on one graph.

If selected, clear the CAT or S/N Mode, Cycle Mode and Smoothing check boxes. Smoothing is
used to reduce variability in data or noise. Please click on the help tab for any information about
these modes.

Set the Excitation filter to Auto, this is the default option. This will automatically move the filter
wheel to the appropriate position for the selected excitation wavelength.

Set the Emission filter to Open (no filter is used) in order to minimize steps in the spectra. This is
the recommended default setting.
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Second order (or higher) light could interfere with experiments where the emission wavelength is
of harmonic frequencies to the excitation wavelength. Usually only a problerm when signal strength
is very low. Second order filters can be used to minimise interference. 250-395, 335-620, 550—
1110 6951110 filter options: If you are looking at a wavelength range that is within one of these
filterranges, you can select your filter manually. However, you are recommended to use the default
options.

Set the PMT Detector Voltage to Medium. This setting can later be adjusted if results are over-
range. If the signalis too high, decrease the PMT Detector Voltage. If the signalis too low, increase
the PMT Detector Voltage. Intensity approx. doubles/halves for a 10% increase/decrease in

voltage. You can manually adjust the voltage too.
c. Selectthe Accessories tab.

If you are not using the temperature controller do not tick the temperature control and
temperature display boxes.

If you do not want to use any other accessories ensure that no options are selected on any of the
Accessories pages. If you are only running one sample at a time or you do not want to use the
multicell holder, select Reset to drive the Multicell Holder to cell position 1 (default position).
Therefore, you will be sure that the position 1 is the one where you have to put your sample.

To use the Multicell Holder: it is an accessory that permits the fluorescence measurements on up

to four samples, while precisely controlling the temperature andrate of stirring. Select the Multicell
Holder option and from the cell diagram, select the number of cells to use.

It is recommended to use the multi-zero option. Because cuvettes can have different intensities,
this field is used when you require all blank readings to consistently start at zero intensity. A reading
will be taken at the set Ex. and Em. wavelengths and at every selected cell position. These readings
will be offset to zero and subsequent readings will have the corresponding offset value subtracted
from each cell.

To enable temperature control (optional): First you have to select multicell holder, if not the only
device we have, the temperature controller, is not available

Select the Temperature Control check box. From the Device drop-down list, choose Temperature
Controller (we do not have a PCB 150 water bath). It has a 0-100 °C range, please do not use the
controller close to its range limits. Enter the required temperature and select which device will be
used to monitor the reaction temperature (block, default, or probe). This monitor will allow data
collection to begin when the temperature of the monitoring device is within + 0.5 °C. The "Port
COM1"is greyed out.

To display the temperature in the Status Display window in real time, select block from the
Temperature display option. You can also installed an available probe in your cuvette of interest
and also select this probe in the T display, Probes generally be used in conjunction with the
Thermostatted Multicell Holder, to monitor the temperature inside the cells, for example to
control that the block T (the temperature controller T) is equal to the T inside the cells.

d. Selectthe Samples tab (not in the Scan app).

Where present (Advanced reads, Concentration etc) this tab allows the input of a list of samples
which will be named in the results file, and if the instrument is being used with a larger number of
samples than the auto-changer, will call for samples by name in the order of the sample table.
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e. SelecttheReportstab. Use this tab to select the format of the report, there is not a company logo
at the moment.

Enter your name in the Name field.
If required, enter any comments relating to your experiment in the Comment field.
Set up your report style by selecting the appropriate check boxes in the Options group.

Do not select the Auto Print since there is not a configured printer. If Auto Print is selected, the

system will send the report information to the specified printer as well as displaying it in the Report
area. However if Auto Print is not selected, the report will be displayed in the Report area only. The
Report area can be viewed by choosing Report from the View menu.

Select the Parameters check box to include your experimental parameters in the report.
Select the Graph check box to include a graph in the generated report.
Set up the Peaks reporting options:

i.  Select Maximum peaks to report the peak with the largest peak intensity that exceeds the
peak Threshold value.

i.  Select All peaks to report all peaks meeting the Peak type criterion and exceeding the
Threshold value.

ii.  Select the Peak type and specify the peak Threshold.

If required, select the X-Y Pairs table check box. You can use the Actual Data Interval by which the
data was collected or you can make the Cary Eclipse Interpolate the points to a new interval.

f.  Select the Auto-store tab. Use this page to set up whether the collected data is to be saved,

Select the Storage option you prefer, “on; prompt at start” is recommended. If you select storage
off, then at the end of the analysis you will need to select file save as from the file menu.

Select the Auto convert option you require. If you choose Select for ASCII (csv) or Select for ASCI
(csv) with Log, at the end of the data collection the system will automatically generate areport and
store the data bothinthe Cary Eclipse format as well as ASCII XY pairs format in the current folder.

Do not select the email option since it is not configured.

g. Finish Setup. Once you are satisfied with your method setup, click OK to confirm any changes you
have made and close the Setup dialog box. Note that the changes you make to the method are
only temporary unless you save the modified method. Incase you want to save the current set up
as a new method select:

Tl [ [0 i e Y our methods MUST begin with your name, but you may extend the name with
| Fle Edit ‘Wiew Comm more descriptive elements if you wish. For example: Pedro_kinetics-

[ Mew Method ... polyphenols . Methods must be saved in the Methods folder, or they will be
2 Open Method ... deleted.
Cpen Data ..

e Method &s ..,

Save Data As ...
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ANALYSIS OF YOUR SAMPLES.

According to the Scan application method previously described.

Please see APPENDIX D for more information on the kind of cuvettes that can be used,

CAUTION:
Do not spill solvents inside the cell compartment. Report any spills.
Please put lids on your cuvettes to avoid any spillages.

Do not put your chemicals directly on the bench. Instead, put your chemicals on a piece of paper
towel. You can also use a plastic recipient.

Please use your own beaker to clean your cuvettes and collect any WASTE you could generate. We do
not have containers for liquid residues in CAF lab.

The spectrometer lid has to be closed for all the measurements.

- Blank: Fill the standard clean quartz/plastic cell (that you will use for your sample) about 2/3 (minimum
1/3) fullwith solvent. Never completely fill a cuvette. Clean the sides of the cuvette with a soft tissue. Close
the spectrometer lid.

For micro cuvettes it is recommended that first you check the correct z position of the cuvette in
the cell holder using the align app. You can also do this for the standard cuvettes if you have a small
volume and you are getting a very low intensity. See Appendix A.

There could be small differences between cuvettes, so it is recommended that you use the same
cuvette per cell holder position (the same for samples and blank). However, if you have matched

pair cuvettes you can use one of them for your blank and one for your sample (s).

- Place the blank solution or the empty cuvette (you do not need to put anything in the cell holder, but it is
not recommended) in the sample compartment, in the position (or positions) chosen in the setup menu.

- Click the Zero button to zero the system. Alternatively, choose Zero from the Commands menu to
perform a zero. When the result is zeroed, the word 'Zeroed' will appear in the Y display box in the top left
corner of the Scan application window.

Caution: If Zero or Start is clicked, and the temperature is not within + 0.5 °C of the
temperature range, then the system will wait for the temperature to fall within the
temperature range before continuing with the measurement.

If you selected multi-zero it will do it for all the positions you selected.

- Using the eject button (Figure 4, raise the screw), carefully remove your blank. Empty it, and then refill it
with your sample solution in the case that you do not have matched pair cuvettes.

- Click the Start button to commence a data collection. Alternatively, chose Start from the Commands
menu. The Windows Save As dialog will appear if you selected this Auto-store option. Enter the
appropriate name for your Scan run and press Save. Save everything in the designated user's folder:
DESKTOP\USERS DATA\YOUR SUPERVISOR'S FOLDER\YOUR OWN FOLDER  (each user should
create his own folder).
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- The Sample Name dialog box is displayed. Place the sample in the same position where you did the zero
with your blank. In the Sample Name dialog box, enter the appropriate name for you sample and click OK.
This will be used for the report.

- The Scan run willcommence and the corrected trace will appear in the Graphics area.

- Once the scan of your first sample (or first sequence of samples if you have selected more than one
sample in the setup) finishes you can follow the same procedure to analyse more samples. You will have
two options: (Al the runs will use the same method previously created in the setup parameters. Remember that you
do not need to zero the instrument again, unless you close the application).

1. If you have selected overlay traces in the setup menu, the default option is to display all the
traces (scans) in the same graph and save them in the same Excel. By all traces | refer to all the
samples you will analyse in the same session. Then the instrument save this graph, not anindividual
graph/Excel file per sample (or per sequence of samples). At the end you can select graph
preferences and select the traces to display in the life graph and save this graph (file save as:
spreadsheet for Excel or batch for graph).

If you haven't selected overlay traces and you proceed with this option, you will have a graph per
sample in your unigue Batch file and one Excel with all the samples.

2. If you have selected overlay traces in the setup menu and you want to have a graph per sample
or per sequence of samples: Every time you finish an experiment, then check that the graph has
been saved. Now you can right click on the graph and remove current graph. When you start your
new sample/or sequence of samples a new graph (and Excel file) willbe generated and will be saved
with only this/these sample trace(s).

If you haven't selected overlay traces and you proceed with this option, you will have a batch file
(with a graph per sample) and an Excel file per sequence of samples.

Remember that if you have not selected the auto-save options in the setup parameters, now you
can select file save as (the data will be stored as a batch file) to save the life window with all the
overlaidtraces. Unless you select focus trace (the one in red) you will be saving all the traces of your
graph. You can also select file, save data as spreadsheet to save it in Excel (overlaid traces or not)
and file, save report as. To save the graph as a picture use the Snipping Tool.

- At the end of the run, the Cary creates the report if you selected this option, You can always select the
print option on the report to save it as pdf. The report will be shown below your data graph.

The spectrum will typically appear in the upper half of the screen, followed by calculation of peak positions
andintensities and generation of areport in the lower half of the screen. The exact view format will depend
upon the Setup parameters. Data analysis will then proceed (see APPENDIX E for more information).

If you are out of scale you can select the Auto-scale option in the Setup and control tasks (Figure 3).

o | BN F@—1 20 AT DS ks AL @M%
=11

/

Auto-scale.

Figure 3. Auto-scale option in the control task bar.
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- Please send all your data by email, do not save it in a pen drive. Please note that data may be purged from
the instrument once a year (after back up) and therefore backing up your data onto your own computer
regularly is advisable.

SHUTDOWN PROCEDURE

- Once the instrument finishes (the start traffic light button will be green) remove your samples and close
the lid.

- If nobody else has booked the instrument just after you, you can close the application and turn off the
instrument and the temperature controller. You may need to wait until the temperature controlleris again
atroom temperature.

- Please leave the PC on.

- Fill in the Excel Logbook (Desktop).

Technical support: Dr Pedro Rivas scs16o@reading.ac.uk
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APPENDIX A: CHECKING THE ALIGMENT OF THE CELL CHANGER FOR MICROCUVETES.

When you are using micro cuvettes or analysing small volumes (less than half of a standard cuvette,
approximately), you may need to adjust the height of the cuvettes with the screw (Figure 4) in order to get
the maximum intensity of your sample (a good alignment). You don't need to do this if before analysing
your samples, the intensity of your
known standard (in the same cuvette
of your sample) is correct.

It is recommended that you do this

; .hEIght procedure with a known standard of
adjustment _ _ _
- screw recognisable intensity.

First you need to open the Align app
and turn on the instrument.

Then you must put the sample at the
cell position currently aligned with the
excitation and emission windows. If
you don't know this position you can
close Align, enter in Scan < Setup <
Accessories and select reset to drive

the Multicell Holder to cell position 1 (default
position). Then close Scan and enter in Align.

o Vew Commands Hep Go to the Cary Tab and select the Fluorescence

e i : Data mode and the wavelength setup and PMT

93939 411.96

(7 it B

650.00 voltage. Be aware that you will see last user's setup.
Em_ "8 The Excitation and Emission wavelengths will be

3

M the ones where your sample produces
fluorescence. You can put the default values for
the other parameters. You can see an example in
Figure 5.

Then you must adjust the screw until you see the
highest intensity on the graph tap. Turning the
height adjustment screw in a clockwise direction
will raise the cuvette. Turning the height
adjustment screw in an anti-clockwise direction will
lower the cuvette. You can adjust the screw with
the lid open but as a precaution do not do it if you
have selected a UV wavelength (less than 400nm).

For a micro cuvette like the one shownin Figure 10,
the best positionisinanintermediate one between
fully clockwise and fully anti-clockwise.

Figure 5. Example of Align Set up.

Once the screw position has been selected you
can close the Align app and open the app you wish to perform your experiments.

Caution: If you are performing controlled T experiments, it is better if you control the T of the solution
inside the cell.Some users have observed that depending on the height of the cuvette the T accuracy of
the T controller may not be so effective.
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APPENDIX B: APPLICATION/PROGRAM DESCRIPTIONS.

The Cary Eclipse software comprises modular software applications, which means that you can choose
the application you need, depending upon what you want to do. For example, if you want to perform
quantitative analysis, use the Concentration application. If you want to perform scanning, use the Scan

application.

Click the links below to learn more about the software application in which you're interested.

For more information see Help Menu and Part 3 Eclipse operation ppt in the theory folder (desktop).

Advanced
Roads

Align

..................................

I

ADL app: ADL is pre-defined template for writing ADL (Applications Development Language)
programs. The ADL Shell gives you a pre-defined template for writing ADL (Advanced Data
Language) programs. Rather than needing to write the code for basic functions such as
graphing and filing, the ADL Shell has a number of these commands already implemented so
you can build on that. For example: New Syntax to cater for 2 monos. etc. e.g: Read(400,500)

The Advanced Reads application allows you set up methods to read multiple samples in a
single run. Features include finding the mean of multiple readings of the sample solution,
finding the mean of multiple sample aliquots of the sample solution, et cetera.

Onlytobe usedunder CAF technical supervision. For your Cary instrument to operate at peak
performance, you must ensure that the instrument and (where applicable) lamp are correctly
aligned in the optical path. Poor lamp alignment or the use of old, failing lamps may decrease
the signal-to-noise ratio and adversely affect the performance of your  instrument. The
Align application enables you to perform alignment procedures of your samples too.

The Applications Development Language (ADL) is a BASIC-like spectroscopy language
that is built into the Cary software. You can write your own Cary interface to set up the

------------------------------------ instrument, collect and store data, calculate results and create reports.

Caty Help

]

Concentrahon

Kmehcs

Helpis available for every program included in the Cary software suite.

The Concentration application is used to automatically determine the concentration of an
absorbing sample, using up to a 30-point calibration for guantitative analysis. The
application enables you to select from several curve fit types for the calibration. Based on
the fit type selected, it then calculates the coefficients of the fit equation and the
correlation coefficient and prints these in the Report area. The concentration values of
samples are then obtained by measuring each sample against the calibrated fit equation

Use the Kinetics application to measure the increase or decrease in emission intensity as a
function of time. From this you can obtain an intensity versus time plot. The features of the
applicationinclude:
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Scan
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Simple Reads
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Information
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Themal

. \
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- Calculation of Zero Order, First Order and Second Order reaction rates from intensity

versus time data.

- Selectable time window for calculation.

- Overlay of the best-fit line on raw data.

- Automatic or manual estimates for the First Order and Second Order Marquardt fitting.

The Kinetics application enables you to determine whether a single wavelength is changing
overtime. If youwish to collect scans as a function of time in order to determine whether the
spectrum is changing, use the Cycle mode option in the Scan application. The Cycle mode
option is available from the Options page of the Setup dialog box.

This application enables you to scan samples across a wavelength or wavenumber range and
manipulate the collected data. You can choose various display modes for the collected data
depending on the type of sample you are measuring and the Cary accessories that you are
using.

Use the Simple Reads application to perform simple fluorescence, phosphorescence and
bio/chemi-luminescence readings of samples. In addition, simple mathematical operations
can be performed (via the User Collect option) on readings performed at multiple
wavelengths.

This application enables you to enter your laboratory details, to select the Cary instrument,
and store the instrument's serial number. The information stored here is then made
available to the reporting functions of all the other applications.

The Thermal application enables you to perform thermal analyses on DNA using one of the
Cary accessories with temperature control. Once the data is collected, you can choose to
calculate the melting temperature, Tm, by either the derivative or hyperchromicity methods.
The hyperchromicity methods also allow you to determine thermodynamic parameters
suchas S, IH and G

Use the Thermal application to measure the increase or decrease in emission intensity as a
function of time. From this you can obtain an intensity versus time plot. In addition, you can
also perform polarization measurements as a function of temperature.

This program is only to be used by service personnel. The Validate application enables you
to optimize the settings and validate the accuracy of the instrument by executing a number
of pre-defined tests. The tests are preset with default parameters that comply with
international standards for Good Laboratory Practices.

The Lifetimes application is used to measure phosphorescence lifetimes, and therefore is
only available in phosphorescence mode.

The Lifetimes application measures the average amount of time a molecule remains in the
excited state following excitation. Where:
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Lifetimes (time resolved)
A + Excitation -> A*
A* -> A + Emission

It is a time-based measurement (like Kinetics) where the change in intensity is usually due
to uni-molecular processes. The shape of the decay curve produced by a Lifetimes
measurement is sensitive to the environment that the molecule is in. For this reason, it is
often used as a probe technique to determine what the molecule is experiencing.

-C The Ratio application is used to measure a change in the intensity at two different
Lo wavelengths. It is used primarily to measure wavelength shifting dyes which shift their
Rato wavelength maxima when they bind to ions.

Use the Ratio application to measure excitation or emission shifting dyes at two different
emission or excitation wavelengths as a function of time. From this you can obtain an
intensity versus time plot. The features of the application include:

° Calculation of Zero Order, First Order and Second Order reaction rates from
intensity versus time data.

o Selectable time window for calculation.

. Overlay of the best-fit line on raw data.

. Automatic or manual estimates for the First Order and Second Order Marquardt
fitting.

The Ratio application enables you to monitor the influx of intracellular ions by ratioing two
wavelengths changing over time. If you wish to collect scans as a function of time in order
to determine whether the spectrum is changing, use the Cycle mode option in the Scan
application. The Cycle mode option is available from the Options page of the Setup dialog
box.

The GLP (Good Laboratory Practice) Administration application is not compatible with Microsoft Windows
7 and Windows 10 operating systems.

This application is used to protect the system from unauthorized use, enabling application-specific
privileges to be turned on or off by the system administrator. The GLP Administration application controls
the access privileges of user groups operating the Cary Eclipse. The method of controlincludes the access
of workgroups (which can be groups of one user) to the Cary Eclipse software, including the ability to reset
the instrument or modify reports and methods, and the establishment of passwords. If this application is
operational, users willneed to be registered, have auser name and a valid password before they can access
the various privileges.
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APPENDIX C: ACCESSORIES.

We have different accessories that can be used with the instrument. However, before usingthemyou have
to look for technical assistance since they will need to be installed. A new SOP and R.A will be needed when
using an accessory.

- Manual polarizers: One of the most effective ways of studying the rotational motion of molecules in
solution is by using fluorescence polarization. With the Manual Polarizer Accessory, you can calculate the
polarization and anisotropy of a sample.

- Stirring switch (Figure 6);The thermostatted 4 Position Multicell Holder permits fluorescence
measurements on up to four samples, while controlling the temperature and rate of stirring. The stir bars
are Agilent part number 6610018900. The bars for standard cuvettes are 6mm long x 3mm wide —PTFE
coated. Agilent also offers a "star” type — p/n 7418000400. If you need a stir bar for microcells you can
check out the websites of Starna Scientific (www.starna.co.uk) or Hellma (www.hellma.com), since Agilent
does not have bars available for Cary Eclipse microcells.

Figure 6. Amplified picture of the Stirrer control and switch.

- Solid Sample Holders enable you to perform fluorescence measurements on solid samples. These are
the available kits: (Figure 7).

a) The 'slide’ d) Optional cuvette holder: we do not have it in CAF.
b) The accessory base e) Optional edge mounter: we do not have it in CAF.

f) Optional powder holder and single Crystal holding

c) Clamps used for attaching samples it
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- Rapid Mix (RX.2000) Accessory: is a stop flow accessory that allows the user to start measuring reagents
as soon as they have been mixed. This is an obvious advantage for reactions that are short-lived.

Figure 7. Solid Sample holder accessories.

- The Cary Temperature probe can be used to measure the temperature of the solution inside a cuvette.
It has two probes, each 2.15 mm in diameter. The probes must be inserted 1 cminto the solution you wish
to monitor. See APPENDIX D for the kind of cuvettes you can use with a probe. The accessory would
generally be used in conjunction with the Thermostatted Multicell Holder. Two types of probe holders are
also supplied -- one designed for use with rectangular cells, and one designed for use with microcells.

APPENDIX D: CUVETTES.

The instrument has a horizontal excitation beam configuration, which limits the kind of cuvettes than can
be used.

- Fluorescence spectrophotometer cuvettes: The standard ones have the 4 polished sides, the incident
beam can exit in 90 degrees angle too. The fluorimeter cuvettes can workin UV.

- Notes on materials:

*UV: Quartz-Most common material, transmission range 190-2,500/170-2700 nm (depending on
manufacturers).

*Optical glass: less expensive than quartz. Transmission range 340-2,000 nm/ 334-2500 nm

*Plastic: it depends on the kind of plastic, but they may not be transparent in part (if not all) of the
UV range. Agilent polystyrene cuvettes: 340-750nm. Plastic cuvettes are available in Stores.
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Cells for use with the Temperature Probe: You can use the probes in any cells that they will physically fit
into -- this excludes flow cells and cells with a path length of less than 5 mm. The probes must not block
the light path in the cuvette.

- Some standard cuvettes than can be used:

*Agilent standard 10 mm path length cuvettes. Rectangular Cells.

Description Volume (mL) Material Quantity Part number
Standard with fitted lid 3.5 uv 2 6610000900
(Figure 8)
Standard with stopper 3.5 uv 2 6610001200
Anaerobic cell 3 uv 1 6610021400
Standard cell with 2 black- |3 uv 1 6610023500

backed mirrored sides

Materials guide for Agilent cuvettes.
Material code Wavelength range
uv 170-2700 nm
There are also Agilent 10 mm path length disposable (plastic) cuvettes.

Figure 8. 6610000900 from
Agllent page.: 293 £.2/pk.

* There are also another providers for standard cells. For example: Fisherbrand cuvettes. 4 polished sides.
(Figure 9). These are available in Stores.
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Description

* Equipped with optically machined walls (optical faces) to ensure optimal transparency along the spectral field
= Polystrene range:340nm to 800nm
= UVrange: 280 to 800nm

® Path length: 10mm

* Compatible with most spectrophotometers and photometers on the market
® Absorption changes: within the £1% interval

® 4-optical faces can be used for spectrofluorimetry techniques

* CE marked--IVD approved

Specifications
Material Polystyrene Path Length 10mm
Type Cuvette Certifications/Compliance CE-IVD
Description 4-clear faces Disposable Yes
For Use With (Application) For spectrophotometry and most of the For Use With (Equipment) Spectrophotometry
common biological and biotechnological
applications
Length (Metric) 12mm
Height (Metric) 45mm
Quantity 100Pack
Lightpath uv
Width (Metric) 12mm
Wavelength Range 280 to 800nm
Capacity (Metric) 4.5mL

Figure 9. Plastic Standard cuvettes specifications. Fisher. Product code 11388773.

- Microcells.

Semimicrocells.

Agilent. 4x10 mm window

Pathlength (mm) |Volume Material Quantity Part number
10 400 pL uv 1 6610021500
Figure 10.

Figure 10. 6610021500. Cell, rectangular, far-UV quartz, fluorescence, 4 x 10 mm aperture,
10 mm pathlength, 400 pl. You only need to fill the bottom of the cuvette. According to
Agilent specialist: "Normally you put the side with the biggest amount of clear area facing
towards the excitation beam, so as to get as much light into the cuvette as possible.”
Accodingto expert user this cell can be usedin the UV, since the bema of the Cary 300 is too
low to permit this.

Figure 10.

*There are also Agilent disposable (plastic) 1.5 mL semimicro cell. (Not for use at elevated temperatures).
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*There are also another providers for micro fluorimeter cells such as: Figure 11.

http://www.internationalcrystal.net/iclsite3/icl101.ntm

. _
Celt However, accordingto expert professor, to use this

;a-‘) cellyouwould need to change the beamfilter to the

- round version as the beam is horizontal. Look for

1

|
Lt

I'YPE SF

. Detector technical assistance if you need to do this.

Semi-micro call with fitted cover
Same as Type 9 bul with 4 clear windows
and clear boltom
Lightpath. 10mm only
Qutaide Dimensions
45 mm high x 12.% mm wide

Figure 11.

Sub microcells.

Ideal for use when you have only a small amount of sample, these cells have the optimum 'Z' height (the
distance between the base of the cell and the centre of the light beam) for the Cary Eclipse fluorescence
spectrophotometers. 2x2 mm window.

Agilent cuvettes.

Pathlength (mm) |Volume Material Quantity Part number
10 40 uL uv 1 6610021600
(Figure 12).
10 40 uL uv 1 6610023700
Figure 12 6610021600. Cell, rectangular, far-UV quartz, fluorescence, 2 x 2 mm

aperture, 10 mm pathlength, 40 pLL

- Other kind of cells than can be used with a different cell holder (not with the currently
installed Multicell Holder and not with the Peltier 1x1 cell holder):

*Long path length cells for use with dilute solutions: Choose from the range of long path length rectangular
cells or the long path length cylindrical cells. Both require the appropriate long path length cell holder.
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* Short path length cuvettes for use with concentrated samples or to overcome the absorbance of the
solvent. Agilent offers micro cylindrical cells with a path length of 1, 0.1 or 0.01 mm. They can be
thermostatted if placed in a thermostatted cylindrical cell holder. The standard cylindrical cell holder can
be used if measurements at only ambient temperature are required.

* Flow cells: Agilent offers 390 ul. volume, 10 mm path length flowcell. Other path lengths also available

APPENDIX E: Data analysis. (Very similar to UV Cary 300 software)

The following file types exist: (in addition to the Excel files)
- Batchfiles: Allmethod, report parameters, data and calculations stored in ONE file.
- Method files: Setup and report parameters stored.
- Data files: Data only stored.
- Graphics template: Saves pre-formatted graphics area.

- These files can be opened with the Cary software, either online or offline. Therefore, you do not need to
turn on the instrument to carry out data analysis. When you open a file and the instrument is off the file will
be opened in offline.

You can also export collected Data: File < Save as < Spreadsheet ASCII (*.csv) or Rich Text Format (* RTF).

- The current run data will be displayed automatically. You may also retrieve previously acquired data from
your data folder (File -> Open Data...). Navigate to your data directory. Be sure to specify file type Data.

How to Combine Data Files into a Batch File—Scan
Step 1 Choose Open from the File menu to display the Windows Open dialog box.

Step 2 A list of stored Batch files will appear. Click the down arrow to the right of the Files of type field and choose
Datatolist all the Data files.

Step 3 Select the Overlay Data check box.

Step 4 Highlight the Data files that you require. Hold down the CONTROL key to select multiple files.

Step 5 Click Open. The highlighted Data files will load into the application and appear in the same graph box.
Step 6 Choose Save As from the File menu to display the Windows Save As dialog box.

Step 7 Alist of stored Data files will appear. Click the down arrow to the right of the Files of type field and choose Batch
tolist all the Batch files. Ensure that the Save only focused trace check box is cleared.

Step 8 In the File Name field, type the file name for your new Batch file.
Step 9 Click Save to create the new Batch file. The current method will be stored with the Batch file.

All'the Data files are now combined into the one Batch file.

- Newly acquired data will show both the graphical spectrum and the report. Previously acquired data will
show the graphical spectrum, but will not show a report or peak list.
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You can print a graph in pdf: select file < print.
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- To generate a report (based upon your Setup -> Reports method parameters) left-click in the _Elearﬂ
graph area so that the black outline and handles are now displayed. From the action buttons on B
the left, select "Recalculate” . The report will now be displayed.

Frint ...

If more than one scan was acquired, you can also click Clear Report to remove all trace reports,

and then click Recalculate to rewrite a report for just the scan(s) visible.

- Use the tools on the ribbon bar to edit and/or annotate the spectrum, add labels or pictures on the graph.
With the calculator display the Maths window where you can perform mathematical manipulations on
collected traces. In addition, it can act as a simple numeric calculator.

=ik " T o] & A R &L =

The graph must be "selected” for some of the tools to be operable. Note that there is no "zoom in" tool.
The standard left mouse click-and-drag action is used to zoomin.

=——— - Youmay use the Scale Graph button to expand or contract the scan to fit the graphic area and
| to set and select pre-set ranges for plotting.

- If you acquire dilution data in order to get the peaks of interest within a quantifiable concentration range,
you will probably want to overlay the graphs. When you have a satisfactory scan, click the Trace
Preferences button and uncheck all scans (traces) except the one to be printed. Click OK.
Only one scan is visible. You can also select add graph EE!; andthentracestoaddrequiredtracesto

the new graph.

- You can Use the Peak L,’,\_ Labels button to adjust the peak labels as desired.
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- You can clik this to edit (write in ) the report. Click anywhere off of the report to exit the edit
@_ mode. You can copy a picture, spreadsheet file or document from another application (for

example, Microsoft Word or Microsoft Excel) into the Report area of the of the Scan application.
To edit these objects, simply double-click them to open the associated application in which they were
created.

= - When the report is satisfactory, click Print to save it as a PDF. You can also select file,
print, PDF

- For more information, go to < Scan help menu < Graph Menu. There are also contour graph and 3D graph
options.

APPENDIXF: FLUORESCENCE THEORY AND INSTRUMENT SPECIFICATIONS:

The instrument can be used to analyse the following photoluminescence types: Fluorescence,
Phosphorescence and bio/chemiluminescence (analysis option selected in < Setup <Data Mode).

Scan Setup mode.
Eclipse has 2 monochromators. We can scan either monochromator. We have three options:
* 1)fix (a single wavelength) excitation mono. and scan emission mono.
— Resultis the fluorescence emission spectrum

e often just referred to as the emission spectrum or the fluorescence
spectrum (we get different intensity values depending on the different
emission wavelengths)

e 2)fix emission mono. and scan excitation mono.

— Result is fluorescence excitation spectrum: different emission intensities
depending on the excitation wavelength.

Can scan both at the same time
*  3)usually with a fixed difference in wavelength

— Synchronous scan

For additional theoretical, software and instrumental information see Power Points in the theory folder
(desktop). There are also several documents printed in the instrument binder (including instrument
specifications).
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